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Chapter 1. Introduction

The installation instructions guide you in installing, updating, and uninstalling
Rational® Programming Patterns V9.6.

Rational Programming Patterns is a set of development tools that are built on the
Eclipse platform (www.eclipse.org). You can think of the Eclipse platform as the
framework and Rational Programming Patterns and other bundled offerings as the
tool contributors.

Rational Programming Patterns is installed on the IBM® Rational Software Delivery
Platform. This platform is a common development environment that contains the
development workbench and other software components that are shared by
multiple products.

Rational Programming Patterns is constituted of the following components:
* The migration procedures.

* An Eclipse client that is integrated with different products, depending on your
environment: IBM Developer for z Systems " (Rational Developer for z Systems)
or Rational Developer for AIX® and Linux.

The client is also always integrated with Rational Team Concert .

If you want to work on Batch Flow Charts and Screen Navigation Charts that
come from the PacDesgin module of VisualAge® Pacbase, you must also install
Rational Software Architect in the client.

* A web client that is integrated into the Rational Team Concert graphic web
interface. It is available as a chargeable component. It can be used to analyze the
applications on the server without updating them. It does not require any
specific installation because the plugins that are used for its operation are
included in the installation package of the Rational Programming Patterns
server. Therefore, the installation instructions of the Rational Programming
Patterns Eclipse client do not apply to the web client. The Rational Programming
Patterns instances that are contained in a Rational Team Concert project area can
be viewed from the Rational Programming Patterns web client with appropriate
licenses only. Refer to [“Specific licenses for the Rational Programming Patterns|
[web client” on page 33/

* A server that is integrated with Jazz" Team Server.

You can install Rational Programming Patterns V9.6 by updating version V9.5.1 or
one of its fixpacks.

You can also complete a full installation of the new version.

© Copyright IBM Corp. 2010, 2017 1
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Chapter 2. Rational Programming Patterns installation
requirements

This section presents the installation requirements for VisualAge Pacbase, the
Rational Programming Patterns Eclipse client, and the server.

Installation requirements for the migration procedures

The migration procedures can be run on data that comes from VisualAge Pacbase
3.5 V10 or higher.

The VisualAge Pacbase installation is documented in the VisualAge Pacbase
installation guide specific to your platform.

The VisualAge Pacbase installation guides are shipped with the VisualAge Pacbase
product. They are also available on the [VisualAge Pacbase documentation site|
(section The administrator's documentation).

Important: The VisualAge Pacbase migration procedures are documented in the
Rational Programming Patterns Knowledge Center, under the entry Updating and
migrating. Expand Migrating Pacbase data to Rational Team Concert, then Extracting
and migrating Pacbase data. The installation and use of the procedures according to
the environment are explained in [The Pacbase analysis and migration procedures|

Rational Programming Patterns Eclipse client installation requirements

You must verify the requirements to install the Eclipse client on System z® or
System p, depending on your environment.

Installation requirements for a System z environment

To install the Rational Programming Patterns client in a System z environment, you
must verify that your workstation meets the minimum hardware and software
requirements for installing the client environment: IBM Developer for z Systems
(Rational Developer for z Systems), Rational Team Concert, and Rational
Programming Patterns. If you want to work on Batch Flow Charts and Screen
Navigation Charts that come from the PacDesgin module of VisualAge Pacbase,
you must also verify the installation requirements of Rational Software Architect.

Verify the prerequisites of each product from the search interface of the
[system requirements| (http:/ /publib.boulder.ibm.com/infocenter /prodguid/v1r0/
clarity /softwareReqsForProduct.html). In this interface, enter the product name
and click the search icon. Select the relevant product in the search results and
select the values of the required fields. Then, submit the search.

Installation requirements for a System p environment

To install the Rational Programming Patterns client in a System p environment,
you must verify that your workstation meets the minimum hardware and software
requirements for installing the client environment: Rational Developer for AIX and
Linux, Rational Team Concert, and Rational Programming Patterns. If you want to
work on Batch Flow Charts and Screen Navigation Charts that come from the
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http://www-01.ibm.com/support/docview.wss?rs=37&uid=swg27005477
http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity/softwareReqsForProduct.html
http://publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity/softwareReqsForProduct.html

PacDesgin module of VisualAge Pacbase, you must also verify the installation
requirements of Rational Software Architect.

Verify the prerequisites of each product from the search interface of the
[system requirements| (http:/ /publib.boulder.ibm.com/infocenter /prodguid /v1r0/
clarity /softwareReqsForProduct.html). In this interface, enter the product name
and click the search icon. Select the relevant product in the search results and
select the values of the required fields. Then, submit the search.

Installation requirements for the Rational Programming Patterns server

To install the Rational Programming Patterns server, you must verify that your
workstation meets the minimum hardware and software requirements for installing
Jazz Team Server and the Rational Programming Patterns server. To use IBM
Developer for z Systems (Rational Developer for z Systems) specific functions, you
can optionally install the IBM Developer for z Systems (Rational Developer for z
Systems) server.

Important: See the important note on the Jazz Team Server version in |“Installing]
[the product required for the server” on page 13

Verify the prerequisites of each product from the search interface of the
[system requirements| (http:/ /publib.boulder.ibm.com/infocenter /prodguid /v1r0/
clarity /softwareReqsForProduct.html). In this interface, enter the product name
and click the search icon. Select the relevant product in the search results and
select the values of the required fields. Then, submit the search.

User privileges requirements

4

You must have a user ID that meets the following requirements before you can
install Rational Programming Patterns:

* Your user ID must not contain double-byte characters.

 To install for all the users of the system, you must have an ID that belongs to
the Administrators group. If you do not have Administrator privileges, you can
install for the current user only.
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Chapter 3. Planning to install the Rational Programming
Patterns Eclipse client and server

Read this section before attempting to install any of the product features. Many
problems can be avoided by planning and understanding the key aspects of the
installation process before actually starting the installation.

IBM Installation Manager

IBM Installation Manager is a program that helps you install the Rational
Programming Patterns product package on your workstation. It also helps you
update, modify, and uninstall any package that you install. A package can be a
product, a group of components, or a single component that is designed for
Installation Manager to install.

IBM Installation Manager helps you keep track of what you have installed,
determine what is available for you to install, and organize installation directories.
It is installed on your system the first time you install a Rational Software Delivery
Platform product.

Installing products from their launchpad is recommended because it automatically
starts IBM Installation Manager. The necessary repository location information and
the packages to be installed are automatically preselected. Moreover if the IBM
Installation Manager version is not compatible with the version required to install
the new packages, its update is automatically proposed.

IBM Installation Manager includes wizards that make it easy to maintain packages
through their lifecycles:

* The Install wizard walks you through the installation process. You can install a
package by accepting the defaults, or you can change the default settings to
customize an installation. Before you install a package, you see a summary of
your selections throughout the wizard. Using the wizard, you can install one or
more packages at one time.

* The Update wizard searches for available updates to packages that you have
installed. An update can be a released fix, a new feature, or a new version of the
product. Details of the contents of the update are provided in the wizard. You
can decide whether to apply an update.

* With the Modify wizard, you can change certain elements of a package that you
have installed. During the first installation of the package, you select the features
to install. If you require other features later, you can use the Modify wizard to
add the features. You can also remove features.

* The Manage Licenses wizard helps you set up the licenses for your packages.
Use this wizard to change your trial license to a full license, to set up your
servers for floating licenses, and to select the type of license to use for each
package.

* The Roll Back wizard reverts to a previous version of a package.

* The Uninstall wizard removes a package from your computer. You can uninstall
more than one package at a time.

For more information, see the Installation Manager documentation.

© Copyright IBM Corp. 2010, 2017 5



Upgrade and coexistence considerations

6

Before installing Rational Programming Patterns, you must install other products
in the same package group. You must then be aware of the compatibility between
the various products to obtain a consistent installation.

Important: You must also ensure that you installed the Pacbase version that
corresponds to the Rational Programming Patterns version. A version
incompatibility can create errors.

General considerations

Some products are designed to coexist and share function when they are installed
in the same package group. A package group is a location where you can install
one or more software products or packages. When you install each package, you
select whether you want to install the package into an existing package group, or
whether you want to create a package. IBM Installation Manager blocks the
products that are not designed to share or do not meet version tolerance and other
requirements. If you want to install more than one product at a time, the products
must be able to share a package group.

When a product is installed, its function is shared with all of the other products in
the package group. If you install a development product and a testing product into
one package group, when you start either of the products, both the development
and testing functionalities are available in your user interface. If you add a product
with modeling tools, all of the products in the package group have the
development, testing, and modeling functionality available.

Note: If you install several packages at the same time, they are all installed in the
same package group.

If you install a development product and later purchase a development product
with increased functionality and add that product to the same package group, the
additional function is available in both products. If you uninstall the product with
the greater functionality, the original product remains

Note: Each product installed into a unique location can be associated with only
one package group. A product must be installed into multiple locations in order to
be associated with multiple package groups.

Each package group is assigned a name automatically. However, you choose the
installation directory for the package group.

When you create the package group by successfully installing a package, you
cannot change the installation directory for the package group. The installation
directory contains files and resources specific to the packages installed into that
package group. Other resources in the packages that can potentially be shared by
other package groups are placed in the shared resources directory.

Important: You can specify the shared resources directory only the first time you
install a package. For best results, use your largest drive. You cannot change the
directory location later unless you uninstall all packages.

IBM Rational Programming Patterns Version 9.6: Installation Guide



Considerations about Rational Programming Patterns

When you install Rational Programming Patterns, you must indicate a package
group for all the products of the client part and another package group for all the
products of the server part.

You can install Rational Programming Patterns V9.6 by updating version V9.5.1 or
one of its fixpacks.

You can also complete a full installation of the new version. You must then choose
one of the following methods:

* Uninstall and reinstall the products in the same package groups.

* Keep the package groups that contain the previous versions of the products and
create package groups to install the new versions of the products. Start working
in the new installation. If everything works fine, you can remove the old
installation. This method is recommended.

If your current Installation Manager version is too old to install Rational
Programming Patterns and its required products, it will be automatically updated
when you install one of the products from a launchpad.

The client part requires the installation of the following products in the same

package group:

* IBM Developer for z Systems (Rational Developer for z Systems) for a System z
environment,

* Rational Developer for AIX and Linux for a System p environment,

* Rational Team Concert,

* Rational Programming Patterns client,

* Rational Software Architect if you want to work on Batch Flow Charts and
Screen Navigation Charts that come from the PacDesgin module of VisualAge
Pacbase.

The server part requires the installation of the following products:

* For a Windows, AIX, Linux, or Linux for System z environment, install Jazz
Team Server and Rational Programming Patterns server in a server package
group.

* For a z/OS® environment, install Jazz Team Server and install the Rational
Programming Patterns FMID.

Note: You can optionally use the functions of the IBM Developer for z Systems
(Rational Developer for z Systems) server. You must then install the Rational
Developer for System z server with the SMP/E tool before you install Jazz Team
Server in the same package group.

Installation methods for Rational Programming Patterns
Several installation methods are available.
You must consider the following questions to determine your installation method:

* What are the format and method by which you access your installation files?

* Are you installing onto your own workstation, or are making the installation
files available to your enterprise?

Chapter 3. Planning to install the Rational Programming Patterns Eclipse client and server 7



* Are you installing with the Installation Manager GUI, or are you installing
silently?

* Do you want to install a trial version before you buy the product?

The following installation methods are possible:

* Installing from a downloaded electronic image on your workstation,
* Installing from an electronic image on a shared drive,

* Installing from a repository on an HTTP server,

* Installing a trial version on your workstation.

Installing from a downloaded electronic image on your
workstation

With this method, you download the installation files from IBM Passport
Advantage® and you install Rational Programming Patterns on your own
workstation.

Installing from an electronic image on a shared drive

With this method, you place the electronic image on a shared drive so that users in
your company can access the Rational Programming Patterns installation files from
a single location. It is also useful when you must install in silent mode on several
user systems.

Installing from a repository on an HTTP server

With this method, you place the files of the IBM Rational Programming Patterns
package, and possibly the associated products, on an HTTP or HTTPS web server
with the IBM Packaging Utility. When they install, users indicate the URL of the
web server that contains these package files to access them. The directory of the
HTTP or HTTPS web server that contains the packages is named a repository.

For more information, see [Chapter 12, “Appendix: IBM Packaging Utility,” on page|

Installing a trial version on your workstation

With this method, you download a free trial version of IBM Rational Programming
Patterns with all its features for a period of 60 days. This version is available from
DeveloperWorks at the following address: Ihttp:/ /www.ibm.com /developerworks/ |
[downloads/r/rppz/|

Installing silently

8

If you install from an electronic image or a repository, you can run Installation
Manager in silent mode.

You can then use a batch process to install, update, modify, and uninstall packages
through scripts. If you are an administrator, it enables you to customize the
installation on the developers' workstations.

A silent installation comprises the following main tasks:

1. If you are planning to install silently on multiple systems, copy the installation
image to a location on a shared drive or server.
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2. Create the response file.
3. Run Installation Manager in silent installation mode.

When you run Installation Manager in silent mode, its user interface is not
available. So you use a response file instead to input the commands that are
required to install the package. An install.xml sample response file is available in
the InstallerImage_win32 subdirectory of the client and in the
InstallerImage_system subdirectory (where systemis aix, 1inux_s390, 1inux_x86,
or win32) of the server. You can use it as is or modify it to your own specifications.

For more information on how to work in silent mode, see the Installation Manager
documentation.

Copying the installation image to a shared drive or server

If you are planning to install silently on multiple systems, you must copy the
installation image to a location on a shared drive where other systems in your
intranet can access it.

To copy the installation image from an electronic image to a shared location, take
the following steps:

1. Extract each of the compressed files that you downloaded for Rational
Programming Patterns and any bundled offerings you want to make available
for silent installations to the shared location where you want to store the image.
Alternatively, you can extract the compressed files on your local workstation
and then copy the uncompressed files and directories to the shared location.

2. In the shared location, verify that you now have the following elements:

* The Rational Programming Patterns installation files must be at the root of
the shared directory.

* A directory must also be created at the root of the shared directory for each
bundled offering that you copied to your shared location.

* Create the response file.
e Perform the silent installations.

Alternatively, you can copy your installation image to a repository on an HTTP
web server and install silently using the repository. To create a repository, you
must use the IBM Packaging Utility. For more information, see |[Chapter 12,

[“Appendix: IBM Packaging Utility,” on page 49,

Chapter 3. Planning to install the Rational Programming Patterns Eclipse client and server 9



10 IBM Rational Programming Patterns Version 9.6: Installation Guide



Chapter 4. Installing the required products

Follow the instructions indicated in this section to install VisualAge Pacbase and
Rational Programming Patterns client and server.

Installing the required products for the Eclipse client

Follow the instructions provided in this section to install the Eclipse client on
System z or System p, depending on your environment.

Installing for a System z client environment

To target a System z client environment only, you must install the IBM Developer
for z Systems (Rational Developer for z Systems) client and then the Rational Team
Concert client. You can also install the Rational Software Architect client.

Installing the IBM Developer for z Systems (Rational Developer
for z Systems) client

Install the IBM Developer for z Systems (Rational Developer for z Systems)
installation package. Do not clear any of the features that are selected by default
on the Features page of Installation Manager.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Team Concert client

You can install Rational Team Concert from its electronic image. But you can also
install it as an optional feature to the IBM Developer for z Systems (Rational
Developer for z Systems) client.

The Rational Team Concert client must be installed in the same package group as
the IBM Developer for z Systems (Rational Developer for z Systems) client.

Note: The Rational Team Concert client version must be compatible with the
version of Jazz Team Server and CCM Application, which is the Rational Team
Concert server part. When you install the Rational Programming Patterns Eclipse
client, you will have to select the Rational Team Concert extension according to
this version.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Software Architect client

Install the Rational Software Architect installation package. Do not clear any of the
features that are selected by default on the Features page of Installation Manager.

© Copyright IBM Corp. 2010, 2017 11
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The Rational Software Architect client must be installed in the same package group
as the IBM Developer for z Systems (Rational Developer for z Systems) and
Rational Team Concert clients.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing for a System p environment

To target a System p environment only, you must install Rational Developer for
AIX and Linux and then the Rational Team Concert client. You can also install the
Rational Software Architect client.

Installing Rational Developer for AIX and Linux
Install the Rational Developer for AIX and Linux installation package.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Team Concert client
You can install Rational Team Concert from its electronic image.

The Rational Team Concert client must be installed in the same package group as
the Rational Developer for AIX and Linux client.

Note: The Rational Team Concert client version must be compatible with the
version of Jazz Team Server and CCM Application, which is the Rational Team
Concert server part. When you install the Rational Programming Patterns Eclipse
client, you will have to select the Rational Team Concert extension according to
this version.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Software Architect client

Install the Rational Software Architect installation package. Do not clear any of the
features that are selected by default on the Features page of Installation Manager.

The Rational Software Architect client must be installed in the same package group
as the Rational Developer for AIX and Linux and Rational Team Concert clients.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

IBM Rational Programming Patterns Version 9.6: Installation Guide



Installing the product required for the server

Before you install the Rational Programming Patterns server, you must install Jazz
Team Server and CCM Application.

* If you install on Windows, AIX, Linux, or Linux for System z, the Jazz Team
Server and CCM Application must be installed with Installation Manager.

Important: If you install the Jazz Team Server and CCM Application in a
version lower than 6.0.3 and later decide to migrate to version 6.0.3, you must
refer to the Rational Team Concert help before you migrate. The migration must
be carefully planned and must be validated in a test environment first.

If you install Jazz Team Server and CCM Application 6.0.3 directly, you will
have to run the repotools -addTables command after you install the Rational
Programming Patterns server to trigger the server indexing. See the Rational
Team Concert help for explanations on this command.

Verify that the IBM Installation Manager page that displays the installation
results shows: The packages are installed. There must not be any error or
warning icon. Moreover the list of the installed packages must contain all the
packages of the products that were selected for the installation.

* If you install on z/OS, the Jazz Team Server and CCM Application must be
installed with SMP/E.

Note: Installing the Rational Developer for System z host components is not
required for using the Rational Programming Patterns server. However, if you
want to use IBM Developer for z Systems (Rational Developer for z Systems)
specific functions, you can install the IBM Developer for z Systems (Rational
Developer for z Systems) server.

Chapter 4. Installing the required products 13
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Chapter 5. Installing Rational Programming Patterns

Follow the instructions provided in this section to install Rational Programming
Patterns.

Installing the migration procedures

You must install and run the migration procedures to access the Pacbase data from
Rational Programming Patterns.

Procedure

1. From the IBM Passport Advantage Web site, download the compressed
installation file of the migration procedures. You must select the file that
corresponds to your environment.

2. Extract the installation image from the compressed file that you downloaded.

3. Install the migration procedures according to the explanations that are specific
to your environment. These explanations can be found in [The Pacbase analysis|
land migration procedures|in the Rational Programming Patterns Knowledge
Center.

Installing the Rational Programming Patterns Eclipse client

After installing the products required for your target environment, you must install
the Rational Programming Patterns Eclipse client on Windows 7 or Windows 8.1.
You install it from its launchpad.

Before you begin

The Rational Programming Patterns client must be installed in the same package
group as the products required for the client part, with the same type of rights
(administrator or user).

To select the installation method that is best suited to your needs, see the
information in [“Installation methods for Rational Programming Patterns” on page|

You start installing in different ways, depending on the selected method:

* Installing from an electronic image on your workstation.

1. Download the installation files from IBM Passport Advantage. Extract the
installation image from the compressed files that you downloaded.

2. To start installing, open the Rational Programming Patterns launchpad.

You start the launchpad program by running the Taunchpad.exe command
from the root of the extracted directory.

* Installing from an electronic image on a shared drive.

Download the installation files from IBM Passport Advantage. Extract the
installation image from the compressed files that you downloaded.

To install interactively from the installation files on the shared drive, run the
Taunchpad.exe command from the root of the extracted directory.

You can also install in silent mode. For explanations, see the note in the
[“Installing silently” on page 8|

© Copyright IBM Corp. 2010, 2017 15
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Installing from a repository on an HTTP web server.
This method assumes that the repository that contains the packages for IBM

Rational Programming Patterns and any bundled offerings was created on the
HTTP or HTTPS web server. For information about how to copy installation

packages to a web server, see [Chapter 12, “Appendix: IBM Packaging Utility,”|

To install the Rational Programming Patterns package from a repository to a web
server, complete the following steps:

1. Start IBM Installation Manager.

2. On the Start page of Installation Manager, click File > Preferences and then
click Repositories. The Repositories page opens, showing any available
repositories, their locations, and whether they are accessible.

3. Click Add repository and indicate the URL of the repository that contains
the installation packages. The new or changed repository location is listed. If
the repository is not accessible, an error icon is displayed in the Accessible
column.

4. Click OK to exit.
Installing a trial version on your workstation.

Download the installation files from IBM Developer at the following address:
[http:/ /www.ibm.com/developerworks,/downloads/r/rppz/} Extract the
installation image from the compressed files that you downloaded.

Proceed like for an installation from a repository. Indicate the directory that
contains the extracted files of the installation image.

Procedure

1.

From the Rational Programming Patterns launchpad, select Install Rational
Programming Patterns to open Installation Manager.

The repository location information is automatically configured. So you do not
have to set it manually in the Installation Manager preferences.

The first page of the Install Packages wizard displays the Rational
Programming Patterns package available for installation. Select it.

You might be prompted to update IBM Installation Manager to a newer version
if one is available. If you click Yes, Installation Manager updates itself and
informs you that it must be restarted to complete the update. Click OK to
restart Installation Manager.

On the Licenses page, read and accept the license agreement for the selected
package. Rational Programming Patterns will be installed with a trial license
that expires in 60 days. You will need to activate the licensed version of the
product to use it after the expiration date.

On the Location pages, the location that already contains the products required
for the client part must be selected.

On the first Features page, select the languages that you want to install for this
package group. On the next Features page, select the features that you want to
install.

Select the feature PacDesign (only for an installation on top of RSA) if you
want to migrate the instances of the PacDesign Batch Flow Charts and Screen
Navigation Charts to Rational Software Architect. If Rational Software Architect
is not installed, the references of the selected features cannot be resolved and
an error is displayed.

You must also select one of the Rational Team Concert extensions: RTC
extension for RTC < 6.0.3 or RTC extension for RTC >= 6.0.3. You must not
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select both extensions. If you select an extension that does not correspond to
the installed Rational Team Concert version, the dependency controls detect the
error and block the installation.

Note: The two extensions are differentiated because each is adapted to the
corresponding version of Jazz Team Server and CCM Application, which is the
server part of Rational Team Concert. Both extensions then contain Rational
Programming Patterns plugins that are adapted to the Jazz Team Server and
CCM Application version.

Click Next.
7. On the Summary page of Installation Manager, click Install.

Results

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Programming Patterns server

You can install the Rational Programming Patterns server on Windows, AIX, Linux,
Linux for System z, or on z/OS.

Before you begin
Jazz Team Server must be already installed.

The Rational Programming Patterns server must be installed in the same package
group as the Jazz Team Server with the same type of rights (administrator or user).

Installing the server on Windows, AIX, or Linux

You access the installation files of the server from its electronic image, or an HTTP
or HTTPS server.

Procedure

1. Depending on the installation method you selected, you must complete one of
the following actions:

* Download the installation image from the IBM Passport Advantage website
and extract all the compressed files. If you are an administrator, you can
make them available on a shared drive.

* Access a repository on an HTTP web server.

For explanations, see the [“Installation methods for Rational Programming]
[Patterns” on page 7.

* Download a trial version of the installation image from the DeveloperWorks
website and extract all the compressed files.

The extracted installation image contains the following elements:
* A docs directory, with the relevant documentation.
* Adistributed directory that contains the following elements:

— A diskl subdirectory, with the Rational Programming Patterns server
repository.
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— Four InstallerImage_system subdirectories, where system is aix,
Tinux_s390 (Linux for System z), 1inux_x86 or win32 (for Windows). These
subdirectories contain the repository for Installation Manager and the
executable files of the Rational Programming Patterns server, adapted to
the operating system.

Each of these directories also contains an install.xml sample response file
for the installation in silent mode.

— For UNIX, the instal1RPP_system admin.sh and
instalTRPP_system_user.sh script files, where system is aix, 1inux_s390
(Linux for System z) or 1inux_x86. Each of these scripts starts the
installation of the Rational Programming Patterns server, according to the
selected operating system. The installation is automatically carried out
from Installation Manager, with administrator or user rights, with all the
preferences and selections already entered for you.

— Two batch command files instal1RPP_win32_admin.bat and
instalTRPP_win32_user.bat, which start the Rational Programming
Patterns server installation on Windows. The installation is automatically
carried out from Installation Manager, with administrator or user rights,
with all the preferences and selections already entered for you.

2. To perform a standard installation, run one of the following files:

* One of the script files for AIX, Linux, or Linux for System z
(instalTRPP_system admin.sh or instalTRPP_system user.sh).

* The instal1RPP_win32_admin.bat or instal1RPP_win32_user.bat file for
Windows.

To specify your own installation selections, install the server from one of the
four subdirectories (InstallerImage_system). Open Installation Manager, enter
the path to the Rational Programming Patterns server repository and select
your preferences on all the Installation Manager pages.

You must select the Rational Team Concert extension that corresponds to the
installed version of Jazz Team Server and CCM Application: RTC extension for
RTC < 6.0.3 or RTC extension for RTC >= 6.0.3. You must not select both
extensions. If you select an extension that does not correspond to the installed
version, the installation will be incoherent.

If you install the server on the Jazz Team Server and CCM Application 6.0.3,
you must run the repotools -addTables command to trigger the server
indexing. See the Rational Team Concert help for explanations on this
command.

Installing the server on 2/0OS

To install the Rational Programming Patterns V9.6 server on z/0OS, you must
install the HAKF960 FMID on the server that is already installed.

Procedure

1.

Access the files that are required to install the Rational Programming Patterns
server on z/0S. To do so, download its electronic image from the IBM Passport
Advantage website and extract all the compressed files. If you are an
administrator, you can make them available on a shared drive.

Note: You can also download a trial version of the installation image from the
DeveloperWorks website and extract all the compressed files.

The extracted electronic image contains the following elements:

* A docs directory, with the relevant documentation.
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This directory contains the HAKF960.pdf installation guide (Program
Directory). It contains all the instructions to install the Rational Programming
Patterns server on z/0S, through SMP/E.

* A zos directory that contains a compressed file for the installation through
SMP/E. This file contains the following installable parts of the HAKF960
FMID:

— IBM.HAKF960.F1.BIN,
— IBM.HAKF960.F2.BIN,
— IBM.HAKF960.SMPMCS.
2. Follow the instructions of the Program Directory in the docs directory.

3. In z/0S, parametrize and run the BRPCPCCM JCL to copy the rpp-profile.ini
file to the directory that will contain all the applications customized
configuration files.

The BLZHOME, BLZCONF, and BLZWORK parameters must be identical to those of the
BLZCPCCM JCL.

4. If you install the server on the Jazz Team Server and CCM Application 6.0.3,
you must run the repotools -addTables command to trigger the server

indexing. See the Rational Team Concert help for explanations on this
command.
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Chapter 6. Post-installation tasks

The Pacbase facet of Rational Programming Patterns runs only with the default
encoding of the workspace in the Software Delivery Platform. If the field Text file
encoding, available from Window > Preferences > General > Workspace, contains
another value than the default value Cp1252, you must change it. Any other value
causes use problems.

Furthermore, make sure that you do not use Unicode characters when you work
with Rational Programming Patterns because this type of encoding is not
supported.

Integrating the Eclipse client and the server with Rational Team
Concert

Rational Programming Patterns is now installed on top of IBM Rational Team
Concert. You must configure Rational Team Concert to integrate Rational
Programming Patterns with it.

About this task

The purpose of this integration is to prepare the building of indexes in the Rational
Programming Patterns server. You must complete the following actions:

e From the Rational Team Concert web client, ensure that the user has the
required permissions for the configuration.

* From the Rational Team Concert Eclipse client, create a project area (if it has not
already been done).

* From the Rational Team Concert Eclipse client, create four language definitions
and associate indexing scanners to them.

* From the Rational Team Concert Eclipse client, select the data streams that will
be scanned.

For an optimum integration, you are advised to modify some default parameters.

Note: After successive installations or reinstallations, the server cache might be
desynchronized with the actual server configuration. For example, the Rational
Programming Patterns scanners might not be displayed. So, the language
definitions that are related to Rational Programming Patterns cannot be correctly
specified. You must then reset the cache.

1. Log in as an administrator to https://[fully-qualified hostname] :9443/ccm/
admin?internal.

2. In the Internal tools entry, click Provision status. All the contributors to the
Rational Team Concert server are displayed. If the Rational Programming
Patterns plug-ins are displayed among these contributors, you must reset the
cache.

3. To reset the cache, click Reset server that is located after Provision status.

4. Click Request server reset. The cache will then be reset when the server is
started again.

5. Stop and start the server again. The server start takes longer than a standard
start because the cache is reset.
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Procedure

1. Create a user and assign permissions to this user.

a.

Start the Jazz Team Server and open its setup wizard from
https://[fully-qualified hostname]:9443/jts/setup.

Follow all the steps that are explained in the Rational Team Concert
documentation [Running the setup wizard]

Create a user, if it has not already been done.

Assign this new user a Developer for IBM Enterprise Platforms Client
Access License.

Verify that the created user has all the repository permissions and the
Developer for IBM Enterprise Platforms Client Access License.

2. Create a project area.

a.
b.
c.

Start Rational Programming Patterns.
Open the Work Items perspective.

In the Team Artifacts view, create a repository connection at the following
address with the administrator user that is already created:

https://[fully-qualified hostname] :9443/ccm

Create a project area.

Note: All the explanations about project areas can be found in the Rational
solution for Collaborative Lifecycle Management documentation.

3. Verify the access permissions.

As an administrator, you must verify that the user who is to create the
language definitions for the Rational Programming Patterns artifacts has the
appropriate access permissions.

a.

b.

From the Work Items perspective of the Eclipse workspace, open the project
area by right-clicking it and selecting Open.

On the Overview tab of the project area, verify the role that is assigned to
the user who is to create the language definitions.

Open the Process Configuration tab. Expand Project Configuration in the
Configuration tree and select Permissions. In the list of Roles, select the
role of the user who is to create the language definitions. In the Permitted
actions tree, verify that the lines Language Definitions and Source Code
Data are selected.
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Figure 1. The Process Configuration tab

d.

Save.

Create the language definitions and select the associated scanners.

You can now create four language definitions:

RPP Design

RPP Design Path
RPP Generated
RPP Macro

Expand the project area in the Team Artifacts view. Then, expand
Enterprise Extensions > System Definitions > z/OS. Right-click Language
Definitions and select New Language Definition. The Language
Definition editor opens. It contains a General tab and a Scanners tab.
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Figure 2. The Language Definition editor

b. Create the language definition for the design artifacts.
1) In the General tab, complete the following steps:
* Enter RPP Design in the Name field.

* Enter an optional description, such as RPP Design File Scanner, in
the Description field.

* Select COBOL in the Language field.

* Enter the following file extensions in the File Extensions field. Only
these file extensions are used by Rational Programming Patterns.
Wildcards cannot be used. Since all these file extensions must be
indicated, you are advised to copy and paste the following lines:

— If you use the entities of the Pacbase facet, copy the lines:

dataaggregate,dataelement,dataunit,pacblockbase,pacdialog,pacscreen,
pacdialogserver,pacserver,paclibrary,pacprogram,pacreport,pacinputaid,
pactext,metaentity,userentity,metadataaggregate,metaentitytype,
pacerrorlabel,paccopybook,pacvolume,pacfolder,pacdialogfolder,pacfolderview,
pacdialogfolderview,paccommunicationmonitor,pacdialogcommunicationmonitor

Attention: Up until version V9.1, the pacmacro extension was one
of the design artifact extensions. A specific language definition is
now dedicated to it. You must then remove it from the language
definition for the design artifacts and create a language definition
for the Macros.

— If you use the entities of the COBOL facet, copy the following lines:

metaentity,userentity,metadataaggregate,metaentitytype,
copy,program,skeleton,micropatterncode,sourcecode

2) In the Scanners tab, remove the default scanner and add the RPP Design
Scanner for this language definition.

3) Save.
c. Create the language definition for the design path artifacts.
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1) Select New Language Definition again.

2) In the General tab, complete the following steps:

* Enter RPP Design Path in the Name field.

* Enter an optional description, such as RPP DesignPath File Scanner,
in the Description field.

* Select COBOL in the Language field.
* Enter the following file extension in the File Extensions field:
designpath

Important: Only this file extension is used by Rational Programming
Patterns. Wildcards cannot be used.

3) In the Scanners tab, remove the default scanner and add the RPP

DesignPath Scanner for this language definition.

4) Save.
d. Create the language definition for the generated artifacts.

Select New Language Definition again.
In the General tab, complete the following steps:
— Enter RPP Generated in the Name field.

— Enter an optional description, such as RPP Generated File Scanner, in
the Description field.

— Select COBOL in the Language field.

— Enter the following file extensions in the File Extensions field. Only
these file extensions are used by Rational Programming Patterns.
Wildcards cannot be used. Since all these file extensions must be
indicated, you are advised to copy and paste the following lines:

- If you use the entities of the Pacbase facet, copy the following line:
cb1pdp,bmspdp,mappdp,mfspdp,ddipdp,txtpdp,cpypdp
- If you use the entities of the COBOL facet, copy the following line:

cb1pdp,cpypdp

Moreover, to trigger the analysis of the sources that are generated
from the Source Code instances, you must also add the name of
each extension, followed by pdp. The extension name is the value
that is indicated in the Source code generated file extension in the
Definition tab of the generic Skeleton that is referenced in the
Source Code. If this value is not indicated, the extension name is the
name of the generic Skeleton. For example, for the txt extension,
you must indicate txtpdp for the scanner.

— In the Scanners tab, remove the default scanner and add the RPP
Generated File Scanner for this language definition.

— Save.

e. Create the language definition for the Macros.

Select New Language Definition again.
In the General tab, complete the following steps:
— Enter RPP Macro in the Name field.

— Enter an optional description, such as RPP Macro Scanner, in the
Description field.

— Select COBOL in the Language field.
— Enter the following file extension in the File Extensions field:
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pacmacro

Important: Only this file extension is used by Rational Programming
Patterns. Wildcards cannot be used.

— In the Scanners tab, remove the default scanner and add the RPP Macro
Scanner for this language definition.

- Save.
5. Associate data streams with the language definitions.

Specify which streams are to be scanned. In the Team Artifacts view, under
Enterprise Extensions, right-click Source Code Data. Then, click Select streams
for scanning. Specify the stream.

If you cannot see any stream, you must create one before you select it. Follow
the instructions in the Rational Team Concert documentation.
With Rational Team Concert V6.0.1 and later, you can configure the source code

data scanning for the stream. To know how to do it, see the explanations in the
Rational Team Concert documentation: [Creating a scan configuration for a|
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Figure 3. How to access the stream selection wizard

6. If the Rational Programming Patterns server is installed for the first time on
Rational Team Concert V6.0.3 or higher, you must run the repotools-ccm
-addTables Rational Team Concert command to index the server content. See
the Rational Team Concert help for explanations on this command.

7. Modify some parameters.
* Memory parameters of the client workstation:
— eclipse.ini.
You must modify the memory parameter of the Software Delivery
Platform. Its maximum value varies according to the operating system and

the memory available. You must then find the maximum value for your
configuration.
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To do so, edit the eclipse.ini file that is located directly under the root of
your Software Delivery Platform.

The Java™ heap size is set to 1024 by default (in -Xmx1024m). You can
increase this value to adapt it to your configuration.

Note: For an installation in 32-bit mode, the maximum value is 1.5
gigabytes.
— scm.ini.

The migration of data from Pacbase to Rational Programming Patterns
uses the scmtools to save the migrated data in Rational Team Concert

You must modify the scm.ini file like the eclipse.ini file.

The scm.ini file is in ...\scmtools\eclipse. The Java heap size is set to
512 by default (in -Xmx512m).

* Memory parameter of the server:

You can adapt the server.startup.bat file that is in the ...\server directory.
In a 64-bit environment, and if the server allows it, you can modify the line
set JAVA_OPTS=%JAVA_OPTS% -Xmx4G to increase the maximum memory in use
to 8G.

* Properties of the Rational Team Concert server:
— No creation of duplicate components.

By default, the component names are not unique in the Rational Team
Concert repository. To avoid inconsistencies, an administrator is then
advised to prevent users from creating components whose names are not
unique.

a. Log in as an administrator to https://[fully-qualified
hostname] :9443/ccm/admin.

In the Configuration entry, click Advanced properties.

Scroll the properties down to the SCM category. Scroll the category
down to com.ibm.team.scm.service.internal.tasks.InternalScmService.

d. Find the property Encourage component names to be unique.
e. Click its current value (false by default) and change it to true.
f. Click Save at the beginning of the properties page.
— Maximum number of files in source code data resource.
With this modification, you avoid a too large memory consumption.

a. Log in as an administrator to https://[fully-qualified
hostname] :9443/ccm/admin.

In the Configuration entry, click Advanced properties.

Scroll the properties down to the Source code data collection category.
This category contains the line
com.ibm.team.enterprise.internal.metadata.collection.service.Metadata
CollectionService.

d. Change the value of the property Max. number of files in source code
data resource. Click its current value and enter 100 instead.
+ DB2® parameter:

To run Rational Team Concert with a DB2 database, you can see the jazz.net
site for information about the DB2 tuning. To import large DB2 databases,
you must increase the following values:

db2 UPDATE DB CFG FOR CCM using LOGPRIMARY 100
db2 UPDATE DB CFG FOR CCM using LOGSECOND 100
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where 100 is the increased value. To see the values, use the following
command:

db2 GET DB CFG FOR sample |grep '(LOG[FPS]"

You obtain the following values:

Size of journal files (4 Kb) (LOGFILSIZ) = 1000
Number of primary journal files  (LOGPRIMARY) = 3
Number of secondary journal files (LOGSECOND) 2

Results
The configuration steps are now finished.

When you deliver a project that contains Rational Programming Patterns artifacts,
the artifacts will be indexed after the indexing process has been manually or
automatically activated. You will then be able to run searches on the server
repository.

Managing a Rational Programming Patterns local workspace

You are strongly advised against reusing a local workspace that was created with a
previous version of the product. However, running a new migration from Pacbase
is not necessary.

You are advised to start from an empty local workspace and to load the content of
the repository workspace into it. You can reuse the repository workspace that was
used before. The metadata will then be correctly reset for Rational Programming
Patterns and its required products.

Even if it is not advised, reusing a local workspace remains possible. If updating
the local workspace is required in a new Rational Programming Patterns version,
then a migration process for the existing local workspace will be provided as far as
possible. This process might be simple, that is to say an individual migration upon
the opening of an editor, or the migration of an entire workspace in a
command-line mode. In any case, this process will be documented with the
version.

To fully benefit from the evolutions of this new version, you are advised to reindex
the content of the existing local workspace. If you are an administrator, you are
also advised to reindex the content of the Rational Team Concert server.

* To reindex the content of an existing local workspace, open the Pattern Driven
Programming perspective and the Design Explorer view. Right-click each
location and select Rebuild Local Workspace. Then, select Rebuild the mapping
between the designs and the generated files.

* To reindex the content of the Rational Team Concert server, open the Work
Items perspective and the Team Artifacts view. Expand each project area and
expand Enterprise Extensions. Right-click Source Code Data and select Reset
Source Code Data.

Accessing the help

28

The help from the Rational Programming Patterns Eclipse client or server is the
remote help, which requires an Internet connection. With this remote help, you
always have the latest content available from within your product. After you start
the product, you can also install the help locally.
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By default, Rational Programming Patterns is configured to access the remote help
from the IBM Knowledge Center at the following address:

http://www.ibm.com/support/knowledgecenter/SSKPEG 9.6.0

When you install, you cannot select the way that the help is accessed. However,
you can modify it later at any moment.

For more information about installing and configuring help, see the section
[Configuring help content|in the Using the help entry of the IBM Knowledge Center.

To install the help content locally, see one of the following topics:

« To install the help content on the workstation, see [[nstalling help on your|

* To install the help content on an intranet server, see [[nstalling help on an|

intranet serve

Note: The help cannot be accessed from the Rational Programming Patterns web
client. However, you can refer to the help from the Rational Programming Patterns
Knowledge Center.

Managing licenses

Licensing is administered with the Manage Licenses wizard in IBM Installation
Manager. This wizard displays license information and helps you configure the
licenses for each of your installed packages.

Note: The required licenses for the web client is explained in [“Specific licenses for]
[the Rational Programming Patterns web client” on page 33

The license that is provided with Rational Programming Patterns expires 60 days
after installation. You must activate Rational Programming Patterns to use it after
the expiration date.

Using the Manage Licenses wizard, you can upgrade the trial version to a licensed
version by importing an activation kit. You can also enable floating license
enforcement for offerings with trial or permanent licenses to use floating license
keys from a license server.

For more information about the Rational Programming Patterns licenses, see the
[Rational licensing support page| at the following address:

http://www-306.1bm.com/software/rational/support/licensing/

License types

You can buy different types of licenses.
Authorized user license

This license enables a single, specific individual to use a Rational software product.
Purchasers must obtain an authorized user license for each individual user who
accesses the product in any manner. An authorized user license cannot be
reassigned unless the purchaser replaces the original assignee on a long-term or
permanent basis.
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Floating license

This license is for a single software product that can be shared among multiple
team members. However, the total number of concurrent users cannot exceed the
number of floating licenses you purchase. For example, if you purchase one
floating license for a Rational software product, then any user in your organization
can use the product at any time. Another person who wants to access the product
must wait until the current user logs off.

To use floating licenses, you must obtain floating license keys and install them on a
Rational License Server. The server responds to user requests for access to the
license keys. It grants access to the number of concurrent users that matches the
number of licenses that the organization purchased.

Token license

The token-based license model means that you can buy some token licenses.

Token-based licenses can be used with floating licenses only. They cannot be used
for authorized user license

License enablement

If you are installing Rational Programming Patterns for the first time or want to
extend a license to continue using it, you have options on how to enable licensing.

Licenses are enabled in the following two ways:
* Importing a product activation kit

* Enabling Rational Common Licensing to obtain access to floating license keys

Product activation kits contain permanent or term license keys. You purchase the
activation kit, download the activation kit .zip file to your local workstation, and
then import the activation kit . jar file to enable the license. Use IBM Installation
Manager to import the activation kit to your product.

Optionally, you can obtain floating license keys, install IBM Rational License
Server, and enable floating license enforcement for your product. Floating license
enforcement provides the following benefits:

* License compliance enforcement across the organization
* Fewer license purchases

Importing a product activation kit
To install your license key, you must import the activation kit from the download
location or the product media by using IBM Installation Manager.

About this task

You must first purchase an activation kit. Download the activation kit from IBM
Passport Advantage to an accessible workstation. The activation kit is packaged as
a Java archive (.jar) file. The .jar file contains the permanent license key and
must be imported to activate your product.

Procedure
1. Start IBM Installation Manager.
2. On the main page, click Manage Licenses.
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3. Select the Rational Programming Patterns package and click Import Activation
Kit.

4. Click Next. Details for the selected package are shown, including the current
license type and the version range of the license.

5. Download the location for the activation kit. Then, select the appropriate Java
archive (.jar) file and click Open.

6. Click Next. The Summary page displays the target installation directory of the
activation kit, the product that the new license applies to, and version
information.

7. Click Finish.
Results

The product activation kit with its license key is imported to the product. The
Manage Licenses wizard indicates whether the import is successful

Activating floating licenses

If your team environment supports floating license enforcement, you can activate
floating licenses for your product and configure a connection to obtain access to
floating license keys.

About this task

Before you activate floating license enforcement, you must obtain the license server
connection information from your administrator.

Procedure
1. Start IBM Installation Manager.
2. On the main page, click Manage Licenses

3. Select the appropriate Rational Programming Patterns package and click
Configure Floating license support.

4. Click Next
On the Licenses page, accept the license agreement for the selected package

o

6. On the Floating License Support page, select the Enable Floating license
enforcement.

7. Configure one or more license server connections by following these steps:
a. Click an empty field in the Servers table or click Add.

b. If your administrator provided you with information for a redundant
server environment, click Redundant Server. Fields for the primary,
secondary, and tertiary server names and ports are displayed.

c. Enter the host name of the license server in the Name field.

d. (Optional) Enter a value in the Port field for environments where a
firewall is used. Do not assign a value to this port unless your
administrator instructs you to do so.

e. For redundant server environments, enter the names and ports (if
required) for the secondary and tertiary servers

f. (Optional) You can click Test Connection to confirm that the connection
information is correct and that the server is available.

g. Click OK.
8. Click Next.
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9. (Optional) Configure the license usage order for your shell shared or custom
packages. The order of licenses in the list determines the order in which your
package attempts to obtain access to license keys for a given licensed package.

10. Click Finish.
Results

The Manage Licenses wizard indicates whether the floating licenses configuration
is successful.

When you next open the enabled product, a connection is created to the license
server to obtain a license key from the pool of available floating license keys.

Purchasing licenses

You can purchase new licenses if your current product license is about to expire or
if you want to acquire more product licenses for team members.

Procedure
1. Determine the type of license you want to purchase

2. Go to ibm.com® or contact your IBM marketing representative to purchase the
product license. For details, visit the IBM web page on “How to buy software”.

3. Depending on the type of license you purchase, use the Proof of Entitlement
you receive and do one of the following to enable your product:

* If you purchase authorized user licenses, go to Passport Advantage and
follow the instructions there for downloading your product activation kit file.
After you download the activation kit, you must import the product
activation .jar file with Installation Manager.

« If you purchase floating licenses, connect to the [[BM Rational License Key]
An IBM registration is required. You can use your Proof of
Entitlement to obtain floating license keys for your license server.

Optionally, you can also go to Passport Advantage to download the
activation kit for your product. After you import the activation kit, you can
switch from a floating to a permanent license type if you use work offline for
long periods.

To import the activation kit or enable floating license support for your product,
use the Manage Licenses wizard in IBM Installation Manager.

Installing and configuring licenses in silent mode

You can import product licenses and configure floating license support silently, in
the same way you can install packages silently.

You must generate a response file to be used by IBM Installation Manager to
configure your licenses.

When you record the response file, use the Manage Licenses wizard to import an
activation kit or configure floating license support before you exit Installation
Manager. The information necessary for performing these tasks silently are written
in the response file.

For information about silent installation, see [“Installing silently” on page 8|
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Viewing license information

From IBM Installation Manager, you can review the license information of your
installed packages, including the license types and their expiration dates.

Procedure
1. Start IBM Installation Manager.
2. On the main page, click Manage licenses.

Specific licenses for the Rational Programming Patterns web

client

The Rational Programming Patterns instances that are contained in a Rational
Team Concert project area can be seen through the Rational Programming Patterns
web client only if the user has the appropriate licenses. The RPP tab is included in
the menu bar of the Rational Team Concert web client only if these licenses are
active.

A Rational Programming Patterns Web Ul license must be assigned to each user
who wants to access the Rational Programming Patterns web interface. A Rational
Team Concert license higher than or equal to the contributor license is also
required.

To manage these licenses, you must log in to the Jazz Team Server Administration
page. Follow the explanations in [Managing licenses|in the Rational Team Concert.

Then, you just need a web browser.

For explanations about how to use the web client, see in the

Rational Programming Patterns Knowledge Center.
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Chapter 7. Starting the Rational Programming Patterns
Eclipse client

You can start the Rational Programming Patterns Eclipse client from the Windows
desktop environment or the command-line interface.

About this task

To start Rational Programming Patterns from the Windows Start menu, click Start
> All Programs > IBM Software Delivery Platform > IBM Rational Programming
Patterns. You can then create a shortcut on your desktop to easily start Rational
Programming Patterns.

To start Rational Programming Patterns from a command line, type

<product_inst dir>eclipse.exe -product com.ibm.pdp.rpp.product.ide

The Pattern Driven Programming perspective is automatically added to your

workspace and it becomes the default perspective. The PDP editors also become
the default editors.
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Chapter 8. Running Rational Programming Patterns command
lines on AIX

Rational Programming Patterns cannot be installed on AIX. However, a package is
standardly supplied with the Rational Programming Patterns client part to run
some commands on this operating system.

About this task

The package contains the following Rational Programming Patterns commands:
* --refresh to refresh the workspace,

* --daemon to start and stop the daemon,

e --commands to run a list of commands,

* --help to display the help on a specific command.

Procedure

1. Decompress the file that contains the .sh commands. This file is available from
the installation directory of your Rational Software Delivery Platform, under
rpp/resources.

Choose the file that is adapted to your environment:
* rpp-batch-product-aix.gtk.ppc.zip for a 32-bit environment
* rpp-batch-product-aix.gtk.ppc6d.zip for a 64-bit environment

2. Verify that you have the authorization to run the rpp.sh and 1rpp.sh
commands by entering the following command on the AIX machine:

chmod +x *.sh

3. Run the .sh commands on the AIX machine.
Results

In the same way as with the rpp.bat command for Windows, you can create your
own commands by using the API and extension points that are provided. For
explanations, see [User command lines|

You can also use the MAF API. For explanations, see [Navigation in the models|
MAF

Create your plug-in in the Rational Programming Patterns graphical environment
on Windows. Then, you simply put your packaged plug-in in the plugins directory
where you decompressed the package for AIX.

© Copyright IBM Corp. 2010, 2017 37



38 IBM Rational Programming Patterns Version 9.6: Installation Guide



Chapter 9. Testing the installation

Before you can work with the new products, you must ensure that the installation
was successful.

Procedure

1. At the end of each product installation, you must ensure that no error has
occurred. This verification step is indicated in this document for each
installation.

2. Verify that all the products of the client part are installed in the same package
group and that all the products of the server part are installed in the same
package group (different from the package group of the client part).

To do so, start IBM Installation Manager by selecting Start > All programs >
IBM Installation Manager > View installed packages. You must see the
package group that contains Rational Programming Patterns client. Verify that
this group also contains the packages of the required products.

Do the same for the server part.

3. Start Rational Programming Patterns. The Pattern Driven Programming
perspective is automatically displayed.

a. From the Design Explorer view, create a location (similar to a VisualAge
Pacbase database). Right-click and select New > Location. Name this
location and click Finish.

b. Create a Library. It contains the generation parameters of each instance.
1) Right-click the location and select New > Library.
2) Enter the following information in the Library creation wizard:
* Indicate a project name.
* Leave the package to blank.
* Enter the Library name on 3 characters.
* Enter the Library label.
3) Click Finish.
c. Create a Data Element.
1) Right-click the location and select New > Data Element.
2) Enter the following information in the Data Element creation wizard:

* Leave the default project. This project is the project where you
created the Library.

* Leave the package to blank.

* Enter the Data Element name on 6 characters maximum.
* Leave the Parent Data Element to blank.

* Enter the Data Element format (X for example).

* Click Browse in the Generation parameters field. Select the created
Library.

* Enter the Data Element label.
3) Click Finish.
d. Create a Program and test its generation.
1) To create a Program, follow these steps:
a) Right-click the location and select New > Program.
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4. Create a connection to the Rational Team Concert server that will store all the

b) Enter the following information in the Program creation wizard:

* Leave the default project. This project is the project where you
created the Library.

* Leave the package to blank.
* Enter the Program name on 6 characters maximum.

* Click Browse in the Generation parameters field. Select the
created Library.

* Enter the Program label.
* Verify that the option Open editor on finish is selected.
* Click Finish.

2) In the Program editor that opens automatically, specify the type of
code to generate in the following way:

a) Click the Definition tab.
b) In the field Type of COBOL code, select 3: UNIX, WINDOWS.
c) Save the modification with Ctrl + S.

3) To test the generation of the Program, follow these steps:

* Expand the Program line that is nested under the location in the
Design Explorer view.

* Right-click the new Program. Select Generate > Program generation.

The generation starts and a progress bar is displayed.

Important: If an error message indicates that Msvcr71.d11 is not in the
PATH, you must install this d11. It corresponds to the Microsoft® C
runtime library (CRT). You install it in two ways, depending on the
products that are installed in your Software Delivery Platform:

* If Rational Developer for System z V9.1 or one of its fix packs is
installed, copy Msvcr71.d11 from ...\SDPShared\plugins\
com.ibm.etools.cobol.win32+\importer\cobol (where * replaces all
the characters of the version number). Then, paste it to the rpp\BIN
folder of your Software Delivery Platform.

* With IBM Developer for z Systems (Rational Developer for z
Systems) V9.5 or higher, or with Rational Developer for AIX and
Linux, install Msvcr71.d11 from the Microsoft® .NET Framework
Version 1.1 Redistributable Package site (|Ettps:/ / |
[www.microsoft.com/en-US/download / details.aspx?id=26). It is
automatically installed in C:\Windows\Microsoft.NET\Framework\
v1.1.4322. Then, copy it and paste it to the rpp\BIN folder of your
Software Delivery Platform.

artifacts of your applications. These steps are explained in [“Integrating the

[Eclipse client and the server with Rational Team Concert” on page 21/

a.
b.

Start Jazz Team Server.

Create a repository connection from the Team Artifacts view of the Work
Items perspective.

Connect to the project area created upon the integration.

From the project area, verify that four language definitions were created

upon the integration. Expand Enterprise Extensions > System Definitions

> z/OS > Language Definitions. Each of these new language definitions
must be exclusively associated with one of the following scanners:

* RPP Design Scanner
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* RPP DesignPath Scanner
* RPP Generated File Scanner
* RPP Macro Scanner

In the project area, create a stream on the server by right-clicking Source Code
Data and by selecting New > Stream. Save.

Create a repository workspace from this stream by selecting New >
Repository workspace. You can optionally modify the default name. Then,
click Finish.

Share the project in which you created the Library and the Data Element.

a. In the Design Explorer view of the Pattern Driven Programming
perspective, right-click the project and select Team > Share project.

b. Select the repository type (Jazz Source Control) and click Next.
C. Select the repository workspace and create a component by clicking New

component. Its name usually corresponds to the Library name on 3
characters.

d. Select the component.

e. Share the project by clicking Finish.

Upload the new Library and Data Element to the Rational Team Concert
server.

a. Open the Pending changes view.

b. Expand the component line and expand the Outgoing > Share projects

line. The two new instances must be displayed under the project indicated
in their creation wizards.

C. Select the line Share projects. Right-click and select Deliver. The changes
are then uploaded to the server.

Verify that the upload completed successfully and that the two instances are
now on the server.

In the Team Artifacts view of the Work Items perspective, expand your
project area. Verify that the component is in the stream by expanding Source
control. Display the repository files by right-clicking the component and
selecting Show > Repository files. The Library and the Data Element must be
displayed in the Repository files view.

Verify that the server indexing that is processed by the Rational Programming
Patterns scanners is active.

a. In the Team Artifacts view of the Work Items perspective, start an
incremental update of the indexes. Expand Enterprise Extensions > Source
code data. Right-click and select Update Source code data.

b. Start a server search on the Rational Programming Patterns artifacts to
extract the two instances that were previously uploaded to the server.
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Chapter 10. Updating Rational Programming Patterns

IBM periodically provides updates for Rational Programming Patterns. So the latest
updates can be installed as soon as they are available. You can access these updates
from the IBM update server or from a compressed file that you download from Fix
Central. To update the Rational Programming Patterns server that is installed on
z/0S, you must apply the PTF that is available with the fix.

Updating from the IBM update server

With the package updating function of IBM Installation Manager, you can identify
and install the updates for the Rational products that are installed on your
workstation. You must install with the same Windows account that originally
installed the IBM Rational Programming Patterns product.

Before you begin

By default, an Internet access is required to install updates unless your repository
preferences point to a local or network update repository to which your system has
access.

Each installed package integrates the URL of its IBM update repository by default.
To make IBM Installation Manager search for the packages installed in the IBM
update repositories, the option Search service repositories during installation and
updates must be selected in the repositories preferences page. It is selected by
default.

Note: Close all the programs that were installed with Installation Manager before
updating.

Procedure

1. On the Start page of Installation Manager, click Update. The update wizard
opens.

2. If a new release or an update of IBM Installation Manager is found, you must
continue with the installation of the new release or update. Follow the
instructions in the wizard to complete the installation or update of Installation
Manager

3. On the Update packages page, select the package group that contains the
version of the Rational Programming Patterns to be updated. Click Next.

IBM Installation Manager searches for updates in its repositories and the
predefined update sites for Rational Programming Patterns. A progress
indicator is then displayed.

4. If updates are found, they are displayed in the Updates list on the Update
Packages page below their corresponding package. Only the recommended
updates are displayed by default. Click Show all to display all updates found
for the available packages.

* To learn more about an update, click the update and review its description
under Details.
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* If more information about the update is available, a More info link is
included at the end of the description text. Click the link to display the
information in a browser. Review this information before installing the
update.

5. Select IBM Rational Programming Patterns and its new version. Select any
other required or optional updates from the list. You cannot select any of the
updates that are already installed.

Note: You can click Select Recommended to restore the default selections.
Updates that have a dependency relationship are automatically selected and
cleared together

6. Click Next.

7. Read the license agreements for the selected updates. If you agree to their
terms, click I accept the terms of the license agreements. Click Next.

Rational Programming Patterns will be installed with a trial license that
expires in 60 days. You will need to activate the licensed version of the
product to use it after the expiration date.

8. Select the features to be updated.

Select the feature PacDesign (only for an installation on top of RSA) if you
want to migrate the instances of the PacDesign Batch Flow Charts and Screen
Navigation Charts to Rational Software Architect. If Rational Software
Architect is not installed, the references of the selected features cannot be
resolved and an error is displayed.

You must also select one of the Rational Team Concert extensions: RTC
extension for RTC < 6.0.3 or RTC extension for RTC >= 6.0.3. You must not
select both extensions. If you select an extension that does not correspond to
the installed Rational Team Concert version, the dependency controls detect
the error and block the installation.

Note: The two extensions are differentiated because each is adapted to the
corresponding version of Jazz Team Server and CCM Application, which is the
server part of Rational Team Concert. Both extensions then contain Rational
Programming Patterns plugins that are adapted to the Jazz Team Server and
CCM Application version.

Click Next.
9. Review your selections on the Summary page.
* If you want to change the choices you made on previous pages, click Back,
and make your changes
* When you are satisfied, click Update to download and install the updates.
A progress indicator shows the percentage of the installation completed.

10. Click Finish to close the wizard.
Results

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Updating from a compressed file

44

Ideally, this update should be installed directly from the IBM update server.
However, you can also download a compressed file that contains the update.
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About this task

You can select this method in the following cases

* You have a slow or unstable Internet connection and want to use a download
manager that can resume the download.

* You have difficulty accessing the live IBM update servers from behind a firewall.
* You prefer to download the update and install it later.

Procedure
1. Connect to the [I[BM Fix Central|site.

a. Select the Rational product group, the Rational Programming Patterns
product, its version, and the platform. Click Next.

b. Select Show fixes that get me to this version and click Next.

c. Select IBM Rational Programming Patterns followed by the version and
click Next.

d. Sign in.
e. Select your download option and click Next.
f. Click Download now.
2. Extract the content of this file to a folder on your system.

3. Start IBM Installation Manager by selecting, by default, Start > All Programs >
IBM Installation Manager > IBM Installation Manager.

4. From the menu bar, select File > Preferences to specify the location of the
extracted file.

5. On the Repositories page, click Add repository. Browse to the extraction
directory. This directory contains subdirectories. Expand the subdirectory that
corresponds to the client or server installation and select diskTag.inf. Click OK.

6. Click Test connections to ensure that the new repository can be found.
7. Click OK.

What to do next

The local repository is now set. Follow the procedure that is described in
[“Updating from the IBM update server” on page 43|

Updating the server on z/OS

To update the Rational Programming Patterns server that is installed on z/OS, you
must apply the PTF that is available with the fix.

Procedure
1. Allocate host data sets for the fix

A sequential data set must be allocated on z/OS to receive the fix that you will
upload from your workstation. You can do it by submitting the job below. Add
a job card and modify the parameters to meet requirements of your site before
you submit it.

Note: The following code contains the generic values HXXXXXX and UXXXXXX. You
must replace them with the actual values that are available on the support
website

//ALLOC EXEC PGM=IEFBR14

ik
/ /UXXXXXX DD DSN=h1gq.IBM.HXXXXXX.UXXXXXX,
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// DISP=(NEW,CATLG,DELETE),

/! DSORG=PS,

// RECFM=FB,

// LRECL=80,

// UNIT=SYSALLDA,

/1* VOL=SER=volser,

/% BLKSIZE=6160,

// SPACE=(TRK, (103,20))
/1%

2. Upload the fix from your workstation to z/OS

Upload the file in binary format from your workstation to the z/OS data set.
On a Windows system, you can use FITP from a command line to upload the
file. The table shows the commands that are entered by the user, and the values
that are assumed.

User enters: Values

mvsaddr TCP/IP address of the z/OS system

tsouid TSO user ID

tsopw TSO password

d: Drive that contains the fix files

hlq High-level qualifier that you used for the
data set that you allocated in the job above

C:\>ftp mvsaddr

Connected to mvsaddr.

220-FTPD1 IBM FTP CS %version% at mvsaddr, %time% on %date%.
220 Connection will close if idle for more than 60 minutes.

User (mvsaddr:(none)): tsouid
331 Send password please.

Password: tsopw
230 tsouid is logged on. Working directory is "tsouid.".

ftp> cd ..
250 "" is the working directory name prefix.

ftp> cd hlq
250 "h1q." is the working directory name prefix.

ftp> binary
200 Representation type is Image

ftp> put d:\IBM.HXXXXXX.UXXXXXX

200 Port request OK.

125 Storing data set hlg.IBM.HXXXXXX.UXXXXXX
250 Transfer completed successfully

5744800 bytes sent in 0.28 seconds

ftp> quit
221 Quit command received. Goodbye.
3. Perform SMP/E RECEIVE and APPLY for the fix

4. Parameterize and run the BRPCPCCM JCL that is supplied in h1q.IBM.HXXXXXX.F1
to copy the rpp-profile.ini file into BLZCONF.

The BLZHOME, BLZCONF, and BLZWORK parameters must be identical to those of the
BLZCPCCM JCL.
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Chapter 11. Uninstalling Rational Programming Patterns

The Rational Programming Patterns installation process does not automatically
uninstall the previous versions of the product.

About this task

The Uninstall option of IBM Installation Manager uninstalls packages that were
previously installed with IBM Installation Manager.

To uninstall packages on Windows, you must connect with the user account that
installed the product.

You can uninstall Rational Programming Patterns without uninstalling the other
products.

However, if you want to uninstall IBM Developer for z Systems (Rational
Developer for z Systems) or Rational Developer for AIX and Linux, you must also
uninstall Rational Team Concert and Rational Programming Patterns.

Procedure
1. Close all the programs that you installed with Installation Manager.
2. From the start page of Installation Manager, click Uninstall.

3. On the Uninstall Packages page, select the packages that you want to uninstall.
Click Next.

4. On the Summary page, review the list of the packages that will be uninstalled
and then click Uninstall.

5. The Complete page is displayed after the uninstallation finishes.
6. Click Finish to exit.
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Chapter 12. Appendix: IBM Packaging Utility

You can use the IBM Packaging Utility software to copy packages to a repository
that can be placed on a web server available over HTTP or HTTPS. It is useful if
you have different offerings or service updates you want to place in a single
repository in addition to Rational Programming Patterns. You can use this
repository to perform interactive or silent installations.

You can use this utility to perform the following tasks:
* Generate a new repository for packages.

* Copy packages to a new repository. You can copy multiple packages into a
single repository; you then create a common location in your enterprise from
which products can be installed with IBM Installation Manager.

* Delete packages from a repository.

For detailed instructions on installing and using IBM Packaging Utility, see the
Installation Manager product documentation.

To install the Rational Programming Patterns package from a repository on an
HTTP or HTTPS server, take the following steps:

1. Place the installation files in a temporary directory on your workstation.

2. Install the IBM Packaging Utility.

3. With the Packaging Ultility, copy the Rational Programming Patterns package.
4. Copy the output of the IBM Packaging Utility to an HTTP or HTTPS web

server.
5. Copy the installation files for IBM Installation Manager to a shared drive.
6. Instruct users in your organization to install IBM Installation Manager.

7. Provide users the URL for the repository that contains the Rational
Programming Patterns package you created earlier.

Note: You can also use the repository to install silently. For more information
about silent installation, see [“Installing silently” on page 8
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Notices

© Copyright IBM Corporation 2010, 2017.

U.S. Government Users Restricted Rights - Use, duplication or disclosure restricted
by GSA ADP Schedule Contract with IBM Corp.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan, Ltd.

3-2-12, Roppongi, Minato-ku, Tokyo 106-8711 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

© Copyright IBM Corp. 2010, 2017 51



52

Intellectual Property Dept. for Rational Software
IBM' Corporation

20 Maguire Road

Lexington, Massachusetts 02421-3112

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Trademarks and service marks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at [www.ibm.com/legal /|
[copytrades html|

Java and all Java-based trademarks and logos are trademarks or registered
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